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MyUAIbany ~ Creating a File for Grade Upload

Procedure

This topic will cover how to create a Tab delimited, text file from the Grade Roster that will be

used in the Grade Upload process.

P

UALBANY

Hello Elizabeth

THE W@RLD WITHIN REACH

Sign Out

Navigation

MyUAlbany Home
Personal Information
Leave System

Safety Alert

March 7, 2009 - Safety Alert » Read More:

Employment Opportunities
Parking Management
Security Questions

SUNY NY Alert

Announcements

March 31st Employee Recognition Reception » Resd More:
New Feature In MyUAlbany » Read More:

Academic Services and Advising
Supervisors
Help
Done & Internet H00% T
Step Action
1.
Click the Academic Services and Advising link.
2.
Click the Class Schedules, Rosters and Grades link.
[class Schedules, Rosters and Graded
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Elizabeth Professer

[ faculty center i class search ]

Faculty Center

My Exam Schedule

Spring 2009 | Un

rsity at Albany change term

Select display option: (@ Show All Classes O Show Enrolled Classes Only

Class Class Title Enrolled |Days & Times Room Class Dates

&Qﬁ ’f:g‘ AARH 171- Survey of Art Western 136 TuTh 11:45AM - 1:05PM LC 20 Jan 21, 2009-
0001 World 11 (Lecture) May 5, 2009
(5121)

f5 ] AARH 171~ Survey of Art Western 142 MoWe 4:15PM - 5:35PM LC 24 Jan 21, 2003-
0003 World IT (Lecture) May 5, 2009
(8458)

fin B ARH 171- Survey of At Western 136 TuTh 8:45AM - 10:05AM Lc 21 J=n 21, 2003-
0004 World 11 (Lecture) May 5, 2009
(94a7)

View Weeldy Teaching Schedule

Go to top

My Exam Schedule > Spring 2009 > University at Albany

Yeou have no final exams scheduled at this time.

Go to top

Faculty Center Class Search

€ mternet 100% v

Step Action

Click the Grade Roster button.

E
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~
Faculty Center il
Grade Roster = view FERPA Statement
AARH 171 - 0003 Survey of Art Western World IT =
Lecture (8498)
< Meeting Information
Days & Times Room Instructor Meeting Dates
MoWe 4:15PM - 5:35PM = | Elizabath Professor| 01/21/2009 - 05/05/2009
*Grade Roster Type [ pisplay unassigned Roster Grade Only
Approval Status ot Reviewsd
+| _<-add this grade to all students |
1
| B
Hotify Program and Plan
Intended -
0008853239 N “ Soph
10 Albany Studert & Criminal Justice (intsnded) |~oP O™
Intended -
£lbany Student B .
2| [0 |000867293| albany Student B Palitieal Seience (intendeg) | SOPROMore
Intended - N
Albany student -
3| [ |000871684| Albany,Studert C Business Admin (intendad) Junior
Intended -
000870514 N Soph
4 0 sl L Accounting (intended) opnemers
Intended -
5| [0 |000929562| sinany Student £ GRD | ended) Freshman
Visiting Undergraduate -
6 [0 |000960007| ibany Studert F GRD | rieulaed Freshman
College of Arts and Sciences
7| O |000772928| Abany,Studert & GRD - Sophomore
Art/Education Stdies (Minor)
Intended -
8| [0 |000893890|akany Student H GRD | Rhetoric & Communic Sophomore
(intandad)/Business (Minor)
College of Arts and Sciences
9| [0 |000498738| Alsarry Studsrt| GRD |- Senior
English/Psychology (Minor)
an! [T lonnzanesz st Shodact | 11~ | Business Administration - v

& mternet

100% -

Step Action

into an Excel file.

Press the [Ctrl] key and click the Download button to get the list of your students
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o

Facul /- https:// albany.edufzcmd=viewatiachtuserfile=ps.xlsisdirname=¥15043 - Windows Internet Explorer

File Edt View Favorites Toolks  Help

Grad

.. ¥ : { +:
iz |§,https‘#a\bany,edw‘ps‘xls V| % ||| [soome

AARH 1

Lecture

e dr [(4https:Ha\hany.eduﬁcmd:H I_I G- 8 - e

2l
. »
) Tools ~

Spring 2

= Meetin

Days & 1]
MoWe 44

*Grade R

Appr File Download e

Do you want to open or save this file?

El] Name: ps.xls
it} Type: Microsoft Excel Workshest, 26,9K8

From: albany.edu

; ||

[ gpen | zee | [ Cancel |

1 O [#] Always ask hefore apening this type o il
2| O
() Wi fes fomthe ntenet can be ussful,somefles can potentialy
3 [ arm your computer. Ifyou o rot rust the source, do niot open or
Save this fle. What's the risk?

4 0O

s| O

s/ ]

7| OO

s [

s| O

Tistar & & @ Ew

[E3

Step Action

5. A new window will open giving you the choice to open or save the file. Choose

Save.

Press the [Ctrl] key and click the Save button.

Sawve

or

Press [Alt+S].
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~
Faculty Center 7l
Grade Roster = view FERPA Statement
AARH 171 - 0003 Survey of Art Western World IT ==
Lecture (8498)
< Meeting Information
Days & Times Room Instructor Meeting Dates
MoWe 4:15PM - 5:35PM = | ElizsbethProfessor| 01/21/2009 - 05/05/2008
*Grade Roster Type [ pisplay unassigned Roster Grade Only
Approval Status  pot Reviewed
+| _<-add this grade to all students |
Save As
Transcript Note ps. ks From ps - - .
Savein \ e Local Disk [C] vl < @
otify 1D -— Est\m.latej timg - el
[ — D”W";‘a Gt { [C)Documents and Ssttings
1 ey Student & Transfervatell P | Sipownboads
Close this Documents
2| [0 |000867299 albany Studert B o Lantel
= (EmoT
3| [0 |000871684| albany Student C L MSOCache
Deskiop (Z)New Folder
4| [ |o00870514| mjpany Studert 0 [EProaram Files
(IWINDOWS
5| [0 |000sz9s62|albany Studert E J 5490 Grades xis
6 [0 |000960007|akany Student F My Documents
7| [ |e00772928 sy stutert & "'7!
My Computer
8| [ |oo0s93830| Ahany Student H
Qg [brams [ v e
9| [0 [000498738| syany Studert| !
MyMetwork | Savesslme | Microsoft Excelwarksheet v [ ceneel ]
10l M1 lnonzaness | hany Stdent L v
javascript:submitAction_win0{document. wind, GRADE_ROSTER$srt25407); i & Internet H100%  +

Step Action

6. Enter the name of your file into the File Name field.

In this example, enter "8498 Grades".

Click the Save button.

or

Press [Alt+S].
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Faculty Center b
Grade Roster = view FERPA Statement
AARH 171 - 0003 Survey of Art Western World IT ==
Lecture (8498)
< Meeting Information
Days & Times Room Instructor Meeting Dates
MoWe 4:15PM - 5:35PM = | Elizabath Professor| 01/21/2009 - 05/05/2009
*Grade Roster Type [ pisplay unassigned Roster Grade Only
Approval Status  pot Reviewed
Download complete
<- add this grade to all students | s
%  Dowrload Complete
Student Grade | Transcript Note ps.xls from albany.edu
..-_I Donnoated: A
Download ta; C:18498 Grades xls
1| [ (000889329 |aany Studernt & Transfer rate: 26.9KB/Sec
Close this dialog box when download completes
2| [ |000867298|tbany Student B o " "
3| [ (000871684 sy stuctent C [ open | [openFoder | [ Ciose
4| O |0o0870514/ aihany stusent S*0 accounting (intended) sopnomer
Intended -
2lbany Student £ -
5| [0 |ooos29562 | Albany Student £ GRD | ended) Freshman
6| [ |000960007 |slany Studert F GRp |Visiting Undergraduste - g
Hon-matriculzted
College of Arts and Sciences
7| O |000772929|abany Studert & GRD - Sophomore
Art/Education Stdies (Minor)
Intended -
8| [0 |000893890| alhanyStudertH GRD | Rhetoric & Communic Sophomore
(intandad)/Business (Minor)
College of Arts and Sciences
9| [0 |000498728|apany Studerni | GRD |- Senior
English/Psychology (Minor)
vnl M lonnranes |\ | Business Administration - v
& nternet -

Step Action

Click the Close button.
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Faculty Center

Grade Roster = view FERPA Statement

AARH 171 - 0003 Survey of Art Western World IT

Lecture (8498)

< Meeting Information
Days & Times Room Instructor

MoWe 4:15PM - 5:35PM =

“*Grade Roster Type | Final Grade ~

Approval Status  pot Reviewed

Meeting Dates
|ElizabathPratessar| 01/21/2009 - 05/05/2009

[ pisplay unassigned Roster Grade Only

+| _<-add this grade to all students |

] m
rade ] Transcript Note
Hotify 1D Name ade |Basis |Program and Plan Level

Intended -

1| O (00089225 ypany stusert & GRD | criminal Justice (intended) |S°PPO™Or®
Intended -

Albany Student B

2 D 000867299 | Albany Student B GRD Political Science (intended) Sophomoere
Intended - )

3| [0 |000871684) slbany stutert GRD | Business Admin (intendad) |™M°
Intended -

4| [ |000870514) apory Stugeri D S0 pccounting (intended) Sephomars
Intended -

Albany Student £

5 D 000929562 | Albany Student E GRD Art (intended) Freshman

6| [ |000960007 |slany Studert F GRp |Visiting Undergraduste - g
Mon-matriculated
College of Arts and Sciences

7| [0 |000772929 | slbany Student & GRD |- Sophomere
Art/Education Stdies (Minor)
Intended -

8 D 000893890 Albany Studert H GRD |Rhetoric & Communic Sophomoere
(intended)/Business (Minor)
College of Arts and Sciences

9| [0 |000458738  spary Student | GRD |- Senior

[E3

Action

format it correctly for the upload.

Click the start button.

Once the download has completed, you will need to open up your Excel file to
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File  Edit

Wi

s Internet Explorer

Favortss Tools  Help

V‘&"} X ‘Gnug\e |P'

63; ~ [ &) https:fiabany.eduy

* [ @ Self-service Grade Roster

Zp- B b v [rpame v (Tads -

[

Faculty Center

1>

Internet

e
Iﬁ

/‘

E-mail

1“5 Paint

i1 start

Grade Roster

AARH 171 - 0003 _Survey of Art Western World IT

Inkernet Explorer
I
Micrasoft Office Outlook

Launch Internet
& Explorer Browser

@ Mozilla Firefosx
:i Microsoft Gffice word 2003
Micrasoft Office Excel 2003

all Programs D

B view FERPA Statement

|

ndergraduste

[1nstructor [Meating Datas

|Elizabeth Professor| 01/21/2008 - 05/05/2008

) My Documents

{ 5 My Recent Documents »

_9 My Pictures
gj My Computer »

Q My Network Places

[] pisplay Unassigned Roster Grade Only

g- Control Panel ) &
i adminstrative Tooks >
Grade
@ rietnork Comnestions irade |Basis |Program and Plan Level
-~ Intended -
[5g) Printers and Faxes BR0 | criminal Justics (intended) | S°PMeTE=
Intended -
@) Help and Support GRD | o jitical Sciance (intendad) |S°PPOMOrE
Intended - .
@ e SRD | Business Admin (intended) |™M°"
Intended -
=7 Run... SRB | accounting (intended) Sophomore
Intended -
R | ended) Freshmazn
crp |Visiting Undergraduate - Erashman
Mon-matriculated

e w @B

Step

Action

10.

Find the location of Excel on your computer. For this example, it is located in the
Start Menu.

Click the Microsoft Office Excel list item.
Microsoft Office Excel 2003

Page 8
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B Microsoft Excel

RRE=N" BENE= BN =N R R N
Al B

i Fle Edt Wew Insert Format Tooks Dsta  Window Help

- | B Z

| j1 @ !Eﬂrla\

£~ Self ——ﬁrj T

uE

=G| 3 % |- . A -

EBX

Type a question for help =

M A

Zh Book1

=

»

Bi

: Getting Started v x
8| S|

T3, 5ffice online

*  Connect to Microsoft OFfice
Onling

* Gk the latest news about using
Exrel

* Aukomatically Update this st
From the web

More...
Search for:

Example; "Print mors than one copy”

Cateqory Breakdown 309, xisx
Admin User IDs For Testing.xls

Test IDS For MyLialbany
Fortal.xls

Open

SR_Menus.xls

5 Mare...

) Create a new workbook. .,

3

|&nnhamars

lcan |-

5l = lannr75a0a Laternt i, Ir

~ll

javascript:submitAction_win0{document, wind, GRADE_ROSTER$srtaf0);

1) & Internet

H100%  +

Step

Action

11.

Click the File menu.

12.

Click the Open... menu.

13.

Use the dropdown menu to find where you placed your Excel file.

In this example it is on the C: drive.

Click the Local Disk (C:) list item.

Local Disk (i2:)

14.

Click the 8498 Grades.xls list item to select it.

15.

Click the Open button.

Open M

6/26/09
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%]

B Microsoft Excel

Edt Wew Insert Formak ook Data  Window Help

B e T m ; Arial Unicode M5

Motify »

1>

c 8] E F

Name Roster Grade | Official Grade | Grade Basis
Albany,Student A Intended - Cr
Albany,Student B Intended - Pc
Albany Student ¢ Intended - BL.
Albany Student D Intended - Ac
Alhany,Student E Intended - Ar
Alhany,Student F Wisiting Unde

College of Ar
Albany,Student G At/Education

[

Intended - RF
\Albany, Student H (intended)BL
College of Ar
Albany Student | English/Psyc
Business Ad
Albany, Student J Accounting/E
Caollege of Ar
Albany,Student K History/Engli
Intended - Ec
Albany Student L (Minar)
Caollege of Ar
Albany,Student b Mathematics
Albany,Student N Intended - BL
Caollege of Ar
Alhany,Student O Economics/E
Intendad - By
>\J

Ready NUM

2| M1 Jannr72a98 apnn e

Il lean |-

javascript:submitAction_win0{document, wind, GRADE_ROSTER$srtaf0);

€ Internet H100% v

Step Action

16.
Click the Maximize/Restore button.

Page 10
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(4] Fle Edit iew Insert Format  Jools Data  window  Help Type & question for help -8 x

JGE 3@ B9 =@ fimdueers -0 -[B]r U (S[S]=c]s % =5 0 A
A Motify

B c D E F G H
Name Roster Grade | Official Grade |Grade Basis Program and Plan Level
06 [Albany,Student A GRD Intended - Criminal Justice (intended) Sophomaore
00 | Albany, Student B GRD Intended - Political Science (intended) Saphomare
00 | Albany, Student © GRD Intended - Business Admin (intended) Juniar
00 | Albany,Student D GRD Intended - Accounting (intended) Sophomars
Albany,Student E GRD Intended - Art (intended) Freshman
Albany,Student F GRD Wisiting Undergraduate - Non-matriculated  |Freshman

Albany,Student G GRD A/Education Stdies (Minor) Sophomore

Alhany,Student H GRD (intended¥Business (Minor) Sophomore

Albany,Student | English/Psychalogy (Minor) Senior
Albar.student J SUo Business Administration - Senior

Albany,Student K Histary/English (Minor) Saphomare
Albany,Student L Intended - Economics (intended)Business |Sophomore
Caollege of Arts and Sciences -
Albany,Student M Mathematics/Education Stdies (Minor) Sophomaore
Albany Student N Intended - Business Admin (intended) Freshman
College of Arts and Sciences -
Albany Student O Econamics/Business (Minar) Juniar
Albany, Student P Intended - Business Admin (intended) Sophomore

Business Administration -
Albany,Student Q Accounting/Business (Minoryiathematics |Junior

Albany Student R Intended - Business Admin (intended) Saphomare
Intended - Rhetoric & Communic
Albany Student § (intendedyBusiness (Minor) Juniar

Step Action

17. You will need to remove column A.

Left-click on column A to highlight it.

18.
Click the Edit menu.

19.
Click the Delete menu.
| Delete |

20. Enter the appropriate grade for each student in the Roster Grade column.

21. Enter the appropriate grade for the student in the Roster Grade field.

In this example enter "A".

22. Enter the appropriate grade for the student in the Roster Grade field.

In this example enter "b".

23. Enter the appropriate grade for the student in the Roster Grade field.

In this example enter "b+".

6/26/09 Page 11
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Step Action

24. Enter the appropriate grade for the student in the Roster Grade field.
In this example enter "c".

25. Continue entering the appropriate grade for each student in the file.
If a student has a Grade Basis of SUO, you will need to enter #S, #U or | for the
grade.

26. Be sure to Save the file often and when you are finished.
Click the Save button.

217. Once you have all of your grades entered in the Excel file, delete all of the
columns to the right of the Roster Grade column.

28. Highlight all of the columns to the right of the Roster Grade column.
Click the Edit menu.

29.
Click the Delete menu.
| Delete |

30. Since the file can only contain the Student IDs and grades, you will need to delete
the Name column.
Highlight the Name column.
Click the Edit menu.

31.
Click the Delete menu.
| Delete |

32. You will need to remove any column headings as the file should only contain
Student IDs and corresponding Roster Grades.
Highlight Row 1 and delete it.

33. Save the file.
Click the File menu.

34.
Click the Save As... menu.

Page 12
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Step

Action

35.

Click the Save as type: list.

IWeb Page {*.htm; * himl)

36.

Click the Text (Tab delimited) (*.txt) list item.

Texk (Tab delimited) (*,kxk)

37.

Enter "8498 Grades" into the File name field..

Enter the name of your file. You may want to use the Class Number as part of the
file name as indicated in this example.

38.

Click the Save button.

Save

39.

Click the Yes button.

® ¥ A

1 B9 Micrasoft Excel - 8498 Grades.xls
i3] Ble Edt Yiew Insert Format ook

PSS E B9 F @ [ e ricods s

EEX

Type a question for help v |2 B X

Al

A ="000889329"

A

B

000889329

000867289

000871684

000870514

000929562

000860007

000772929

000833830

000488738

000740617

000839932

000BA3ET2

000svgssn

0009464891

000848351

000865902

000884833

000882321

000821032

0007699592

000BA4GRS

000881726

000907839

000836246

ps)

000848576

BN EEEEEEEEEEEEEEEEEEEE

i

.

NNNRAARTA

K 4 » W\ B408 Grades /

Ready

6/26/09
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Step Action

40.
Clck the Close button.

Edt Wiew Insert Format Tools Data  ‘Window Help Type & question forhelp = = @ X

HENEN" RERIE REN N R R AR | !iﬂﬂa‘unlwdeMS ~10 -/ B Z U] =58 % 5] S A
- £ ='000889329"

A B c | o [ E | F [ 6 [ H [
noogagazy
000867299
000871684
000870514
000929562
000960007
000772929
000893890
000438738
000740617
000839932
000863612
nooargasn
000946481
000848951
000865902
000884893
000832321
0o0g21032
000769992
000864668
0o0oaa172s
000907859
000836246
000848576
L

Micrasoft Excel

! ! Do you want to save the changes you made to ‘8496 Grades.txt'?

v | [ caneel |

R EEEEEEEEEEEE

ola|s

7

NHEEEEREY
+ [\ 8498 Grades /

Step Action

Click the No button.
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Step

Action

42.

Click the Start menu.

72 stanrt

or

Press [Alt+F].

43.

You should open up your text file to make sure everything looks OK before you
try uploading the file.

You can use Notepad to do this. If it is not on the Start Menu like it is in this
example, you can find it in All Programs -- Accessories menu.

44,

Click the Open... menu.

| Qpen, ., Chrl+0 I

or

Press [O].

6/26/09
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£ Untitled - Notepad
File Edit Format Wiew Help

eS|

Lookin: | < Local Disk (C:) v 0% m
EY IE=)0el
[& |E3)Documents and Settings
My Recent | |Z)Downloads
Documents | | Intel
— [E=3Liz UPK Test Publisting
@ (EamoT
Desktop MsOCache
IE)Mew Folder
IE)Program Files
(5 WINDOWYS
My Dosuments 2] 8498 Grades.txt
WS, bk
My Camputer
File name: o v [ open |
My Network | Files of type: [ Tert Documents (1) v [ cancal |
Encoding |ANS\ v|

45.

Click the 8498 Grades.txt list item.

46.

Click the Open button.
(-
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I 8498 Grades. txt - Notepad M EE
File Edit Faormat Wiew Help

000889329
Q00867200
000871684
000870514
000929562
Q00960007

Q00772929
Q00893890
Q00498738
000740617
000839532
Q008636Ll:
Q00879880
000946491
Q00848951
Q00865902
Q00884803
000892321
000821032
Q00789992
Q00BB46AE
Q00881725
Q00907339
000836246
000848576
000884824
Q00886605
Q00815173
Q00862736
Q00895531
Q00893438
000903643
000878186
000878329
Q00831889
Q00902124 b+
Q00839710 o+
Q00936789 -
000844651 i
000742423 a
000848835 a
Q00900305 b
Q00862242 b+
Q00875029 b+
Q00794241 b+
Q00820548 a
0008353737 a
000893307 c
000912479 b
Q00882383 b
b
b
a

TARRL A TTTNNAA T TAMLE BN TREAAMAAAATEDR

000923477
Q00830057
000893598

Step Action

47. Check your file. If your file has the nine-digit student ids, be sure the leading
zeros are displayed.

Click the Close button.

48. You are now ready to use this file in the Grade Upload Process.
End of Procedure.

6/26/09 Page 17




